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NuTAP-S61 OVERVIEW

NuTAP-S61 is a portable network TAP device. Embedded with
2 Network Ports and 2 Monitor Ports, NUTAP-S61 can monitor
and redirect any data streams which flow through it. Moreover,
NuTAP-S61’s Console Port allows users to access test data
and configure test variables while serving as an optional
power source for NuUTAP-S61.

Network TAP is a hardware device which allows monitoring
data flows in a network environment dynamically without any
interference.

As mentioned above, NUTAP-S61 is embedded with two
Network Ports and is capable of monitoring all data flows
between two network points. All data traffic flows between
NuTAP-S61’s Network Port AO and A1 can be brought out for
further analysis and research dynamically and without
intervening network environment.

NuTAP-S61 is a compact, lightweight, and highly cost-effective
device that provides 3 different filters for users to choose:
Forwarding Filter, Re-Direct Filter, and Capture Criteria. All
these filters are powered by Xtramus SDFR (Self-Discover Filtering Rules), which makes packet capturing/filtering over Ethernet
easy and convenient.

KEY FEATURE

e Portable and light-weighted, with high-performance and o NuSet-MiniTAP is a utility software designed for NUTAP-S61
reliable test results and runs under Windows® environment. When connecting
NUTAP-S61 with your PC via a RJ45-to-USB cable, it allows
e Filter and redirect TAP streams to monitor port by SDFR users to:
technigue which can ease the loading of monitor PC » Upgrading NUuTAP-S61’s firmware and FPGA
» Monitoring data flows in the network environment
e SDFR (Self-Discover Filtering Rules), a set of filtering rules » Configuring test settings and accessing test results
including Destination Address, Source Address, VLAN, > Setting 2 sets of Session Filter including Port A — Port B

Destination IP, Source IP, Destination Port, and Source Port
and Port B - PortA

e 2 Network Ports and 2 Monitor Ports of 10/100 Mbps RJ45 » Setting SDFR (Self-Discover Filtering Rules). SDFR is a
Ethernet port set of filtering rules including Packets, Bytes, Packet
Broadcast, CRC Error, IPCS Error, Packet Multicast, and
e 1 Console Port which allows users configuring test variables, Transferring Rate.

accessing test results, upgrading firmware/FPGA, and serving
as NuUTAP-S61’s optional power source while connected to PC e Reset Button which allows users to reset all NUTAP-S61’s
with a RJ45-to-USB cable* settings back to default value

e Both Network Ports support Universal Stream Counter (USC), e Ultility Software that supports multi-language user-interface
each USC can contain up to 256 sets of statistics (up to including Simplified Chinese and English
48-bits) including Packets, Bytes, Packet Broadcast, CRC
Error, IPCS Error, Packet Multicast, and Transferring Rate.

* When using Console Port as NuTAP-S61’s power source, please use the
RJ45-t0-USB cable that comes with NuTAP-S61 package. Extending the length
of RJ45-to-USB cable might cause NuTAP-S61 power insufficient.
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SPECIFICATION
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Network Port

Network Port AO

10/100 Mbps Full Ethernet RJ45 Port  |Network Port A1| 10/100 Mbps Full Ethernet RJ45 Port

Monitor Port

Monitor Port MO

10/100 Mbps Full Ethernet RJ45 Port | Monitor Port M1| 10/100 Mbps Full Ethernet RJ45 Port

Console Port

RJ45 Port for Firmware/FPGA Upgrading, Configuration Setting, and NuTAP-S61 Power Supply*

Power Jack 1 x 12V DC Power Jack
General >  Power > SYS
» A0 > Al
LEDs | VetworkPort > 100M > 10M > Full
Monitor Port > MO > Ml
Re-Direct Filter > Segregate: -{H >  Aggregate: =
Button Reset Button Reset Button which allows to set all system settings to default values

NuTAP-S61 filter redirects only the packets that meets user-defined SDFR (Self-Discover Filtering Rules)

Forwarding Filter Description

All packets transferring between Network Port AO and Al that meet filter criteria will be filtered out or let
through

SDFR

> Destination Address » Source Address »  Destination IP »  Source IP

Description
Re-Direct Filter

All packets transferring between Network Port AO and Al that meet filter criteria will be re-directed to the
Monitor Port(s)

SDFR

> Destination Address » Source Address » VLANID »  Destination IP

> Source IP » Destination Port »  Source Port
Description All packets transferring between Network Port AO and Al that meet filter criteria will be captured and stored
Capture Criteria P in NUuTAP-S61’s memory buffer.
SDFR [ Destination Address » Source Address »  Destination IP »  Source IP
. » Broadcast » Multicast »  Unicast
MAC (Data-Link Layer) > VLAN > QinQ (Double VLANTAG) > CRC Error
Filter Protocol > ARP > IPv4 > IPv6

Network (Network Layer) | oyp > IPCS Error > Pattern Check
Protocol (Transport Layer » TCP » UDP > FTP » RTP

All packets transferring between Network Port AO and Al that meet filter criteria will be filtered and stored in NuUTAP-S61’s

Capture-and-Stop memory buffer. System will stop storing new data once the memory buffer is full.

Real-Time

memory buffer. System will keep overwriting old data with new data.

All packets transferring between Network Port AO and Al that meet filter criteria will be filtered and stored in NuTAP-S61’s

» DAJ/SA (Destination/Source Address)

Header Adding >  VLANTAG

» Time Stamp
» IP Header: UDP Header, IP Fragment

Temperature » Operating: 0 °C~ 40 °C (32 °F~ 104 °F) »  Storage: 0 °C~ 50°C (32 °F~ 122 °F)
Humidity >  Operating: 0% ~ 85% RH > Storage: 0% ~ 85% RH
(non-condensing)
Dimension 106 mm x 80 mm x 25 mm
Net Weight Approx. 140g

* When using Console Port as NUTAP-S61’s power source, please use the RJ45-t0-USB cable that comes with NuTAP-S61 package. Extending the length of

RJ45-t0-USB cable might cause NuTAP-S61 power insufficient.
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TECHNICAL TERMS & APPLICATION

SDFR

SDFR (Self-Discover Filtering Rules) is a technology that
makes packet capturing/filtering over Ethernet easy and
convenient.

SDFR’s User- friendly interface can display values such
as Source IP, Destination IP and so on. All these values
(one single value or a specific range of values) can be
input directly without calculating mask.

All captured packets are displayed in real-time without
intervening network flow, and SDFR values can be
changed dynamically during capture procedure.

SDFR parameters include filter of Layer 2 Destination
MAC Address, Source MAC Address, VLAN ID, Layer 3
Destination IP Address, Source IP Address, Destination
Port, and Source Port. Each filter is independent and can
be activated in any combinations.

Forwarding Filter

As shown in the figures down below, transmitted packets
from Network Port AO to Al (or the other way around) that
meet the criteria set in Forwarding Filter will be filtered out or
through.

Packet Forward Filters
Network Network

Port #0 Port #1

A Packet type  Protocols Filter '
SOFR - MAC_DA Fitter '
SOFR - MAC_SA Filter '

SDFR - nml ation P Filter.

SDFR - Source IP Filter '

Packet type ! Protocols Filter '
SDFR - MAC_DA Fittor '
P
d SDFR - MAC_SA Filter ~————
- Broadcast / Multicast / Unicast SOFR - Destination 1P Fiter '
= CRC /IP Checksum Error SDFR Filtering
-IP/IPv / ICMP / ARP —'
_TCP/UDPIETP SDFR - Source IP Filter

~Mode 0:IP1 S (N) S IP2
- Mode 1 :(N)=IP1 or (N)=IP2

Capture Criteria

Transmitted packets from Network Port AO to Al (or the
other way around) that meet the criteria set in Capture
Criteria will be captured and stored in NuTAP-S61’s buffer

memory.
Packet Capture Criteria
Network Network
Port #0 Port #1
/ N \,;,/}
( T
Neo i

- CRC /IP Checksum Error
-IP /1Pv6 / ICMP / ARP

- Broadcast / Multicast / Unicast
-TCP/UDP/FTP

Packet type / Protocols Filter Filter

| =
SDFR - MAC_DA Filter ',Fp == '
SDFR - MAC_SA Filter ' '_'; e

SDFR - Destination IP Filter ' \ Capture Buffers
SDFR - Source IP Filter '
\ Capture Buffers

_—— SDFR Filtering
-Mode 0: DAT S (N) S DA2
-Mode 1 (N)=DA1 o (N)=DA2
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Re-direct Filter

As shown in the figures down below, transmitted packets
from Network Port AO to Al (or the other way around) that
meet the criteria set in Re-direct Filter will be captured by
NuTAP-S61 and transferred to Monitor Port(s) judging by its
settings (Aggregate, Segregate, or Multi-Mirror).

Packet Re-direct Criteria
Network Network
Port #0 Port #1

o it
" Vi
(=
- Broadcast / Multicast / Unicast

. S
> Packet Protocols Fil
» Lol =) | CRe T ChecksumEner

SOFR - MAC_DA Fier — _IP/IPV6/ICMP | ARP Add Extra DASAID,
- -TCP/UDP/FTP Time, Slamp CRC by requested
Packet type / Prolocols Fiter
s = |
. o SOFR - MAC_DA Filter
, o |

" SOFR-MAC_SAFhe P

Monitor
SDFR - Destination 1P Fiter » Headers Add ’:/\ Port #8
'SDFR - Source IP Filter w

SDFR Filtering
-Mode 0: SAT = (N) S SA2 & — %
- Mode 1 :(N)=SA1 or (N)=SA2 Ea— Headers Add
»

Monitor
Port #A

Aggregate, Segregate and Multi-mirror support

Aggregate

As shown in the figures down below, transmitted packets
mentioned previously will be captured and transferred to
ONE designated Monitor Port.

Captured and sent Monitor Port Mo

to ONE designated .
Monitor Port K
O= >~
Network Port P“'“’t Flow Network Port
A0 A1l

Segregate
Transmitted packets mentioned previously will be captured

and transferred to ONE designated Monitor Port judging by
the direction of packet-transmitting flow (AO—A1 or A1—AQ0).

Captured and transferred to ONE Menitor Port MO

designated Monitor Port judging by the .
direction of packet-transmitting flow (
—

o Packet Flow -

Network Port Network Port
A0 A1l

Monitor Port M1

Multi-Mirror

As shown in the figure down below, transmitted packets
mentioned previously will be captured and transferred to
BOTH Monitor Ports.

Monltor Port MO/M1
Captured and transferred
to BOTH Monitor Ports Ci .
Network Port Packet Flow Network Port
A0 A1l
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Universal Stream Counter (USC)

Universal Stream Counter Report
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When monitoring data flows in a network environment
with Network TAP devices, it is common to use packet
analyzers (or sniffers) for capturing and analyzing packet
frames. However, information acquired this way may be
too vast and complicated for pinpointing the possible
cause of network/product problems.

Unlike these common packet analyzers or sniffers
mentioned above, Universal Stream Counter (USC) offers
real-time statistics of network events during packet
monitoring and capturing, as shown in the figure down
below:

Universal Stream Counter

Network Network
Port #0 Port #1
N 1 r
A" -
e 1 =
% T
[\- i - I I ||
! Packets | Bytes Broadcast | Mulicast | CRC | 1P Rate
4| Src.lP L eror | Checksum | (Mops)
error
1721753 9430 700562 | 120 0 1 o 12
DA/SA/VID/ (Base+0)
MPLS_Label / T
DIPTGPIDRY 1721754 40998 | 5100562 | 19 ] o |o 168
® (Base+1)
1721755 13003 | 17424002 | 23 12049 |0 |2 206

(Base+2)

Both of NUTAP-S61’s Network Ports support Universal
Stream Counter (USC), each Network Port contains 1 set
of USC with packet filtering rules based on:

> DA (Destination Address)
> SA (Source Address)

> SIP (Source IP)

» D Port (Destination
Port)
> VID (VLAN ID) > S Port (Source Port)

> MPLS » VLAN CoS
(Class of Service)
> DIP (Destination IP)

Also, each USC can contain up to 256 sets of statistics
(up to 48-bits) including:

> Line Rate (Mbps) > Multicast
> Packets > IPCS Error
> Bytes » CRC Error

> Broadcast

Test Instruments and Networks

Ciperation Mode
* MormalMode  © Jitker Mode

Universal Stream Counter can run under two modes:
Normal Mode and Jitter Mode. Under Normal Mode,
you can monitor/analyze statistics mentioned previously.
However, when under Jitter Mode, additional statistics
regarding to packet jitter will be displayed:

Current  |Current time interval between packets

Maximum |Maximum time interval between packets

Minimum |Minimum time interval between packets

The variance of time intervals between Maximum
Delta Time and Minimum Delta Time.

*ns: Nanosecond

Pattern Check

Forwarding Fi\terl Capture Criteria | Re-direct Filter Pattern Check

™ Pattern 0 [ Description
The utility will compare the user-defined
value set here with all packets received from
cotresponding port. All packets contain with
the matched values will be captured.

Data IEIU 00 00 00 00 00 00 00

ByeEnable: ¥ W ¥ ¥ ¥ ¥ F ¥
Result IDD 00 00 00 00 00 00 00

Pattern 1

Dists IDD 00 00 00 00 00 00 00

ElyleEnaI:\e'7 FFFFVFFF

Result IEIU 00 00 00 00 0O 00 0o

NuSet-MiniTAP can compare the user-defined value set
here with all packets received from corresponding port. All
packets contain with the matched values will be
forwarded/captured/re-directed according to settings.

Pattern Check Pattern Check
Network Port % ’ Network Port % "
AD Forwarding A0 Forwarding
Patiern Malsh Patiern Match
) — |~ Capture BB — [~ Capture
Network Port Re-direct Network Port Re-direct
A1 ﬁ} Al
NuSet-MiniTAP Dynamic Chart
X
| B % u
lupdate | Lne  Pe B
Network Port AD S2e 65 ~ 127 Al

B sz= 128 ~ 255
Bl size 256 ~ 511
e B sze 512 ~ 1023

B see>1024
B erosdcast
B Mruiticast
0354.45 0854 50 08:54 55 08.55.00 085505 085510 E. RRTP =
Network Port AT B see6s ~ 127 Al
—=
- P —
=7
\\/

085445 035450 0BS54SS 085500 035505 085510
Monitor Port AD,AT

\V4
B Mriticast

085445 085650 085455 085500 (85505 (85510 B RerTR -
Vertical Axs Scale (Port AD) Vertical Axis Scale (Port A1) | [ Verticl Axis Scae(Port AD,AL) 1
Packet(pps) © Auto © UserDefine =" | | Packet(pps) @ Auto © UserDefine " || | Packet(pps) © Auto C User Define ___J‘
M [ Mt [1050 Mok [ Masimun: [0 | | mevnen: [ Maxmun: [0

|

Horizontal Axts
Start Time: [201 5456 End Time:

NuSet-MiniTAP provides a graphic interface which allows
you to monitor/interpret network packet streams easily.
You can set the graphic display as Line, Pie or Bar chart.
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GENERAL DESCRIPTION OF NuTAP-S61

1 12V DC Power Jack 2 LEDs
3 RJA45 Ports 4 Reset Button

Control via NuSet-MiniTAP

NuSet-MiniTAP is a utility software designed for NuTAP-S61 and runs under Windows® environment. With NuSet-MiniTAP’s GUI
(Graphic User Interface), users can configure test parameters, access test data and upgrade system firmware.

To use NuSet-MiniTAP, you need a USB-to-RJ45 cable, and connect this cable between NUTAP-S61’s Console Port and your PC’s
USB port as shown in the figure down below.

7 NuSiet-MiniTAP =10/ x|

Ele Config Report Service Languages Help
e @ XTRAVILE

PC's USB Port =

=
Reconned:

NuTAP-S61

Network Pork AD Network Port A1 | Moritar Port MO Manikor Port M1

B B | ¥ @
Conter  USC | Cop,AD Cop.Al

B T MuTAP-861
D System Information
&M
© MAC:39-D5-39-D5-39-D5
% Network Port 40 Status
-0 Conneciion Mode : Auto Al
20 Link Status
© Link: Link Down
<) Speed: NiA
© Flow Contral : Off
) Rate Control : Off

NuTAP-S61
2, Network Port A1 Status

= conso',e ,m ) Connection Mode : Auta All
PC Running s ; " 50 Link Status
NuSet-MiniTAP =" e S NS et ipl AP
) Flow Cortral - Off A LS EA Vo ._././/,._.hr.-.rl
O Rate Control : Off Network TAP with Multi-Redirect and Smart-Filtering Rule
23 Monitor Part M0 Status

) Connection Mode : Auto All
-0 Link Status

Connected via
RJ45-t0-USB Cable

L

B

e System Setting
e Firmware/FPGA Upgrading
e Power Supply via USB Port

© Link: Link Down
© speed: Nis
© Flow Contral : O
%5 Monitor Fort M1 Status
) Connection Made : Auta All
-0 Link Status
- Link : Link Down
© Speed:NiA
© Flow Contral : Off

P

[e—=3 Connected 4
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RELATED PRODUCTS
NuTAP-311:

Network TAP with Two 10/100/1000 Mbps Network Port/Monitor
Port

CONTACT INFORMATION

Website: www.xtramus.com
E-mail: Sales@xtramus.com
TS@xtramus.com
TEL: +886-2-8227-6611
FAX: +886-2-8227-6622
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